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Alocarea resurselor este procesul de repartizare a resurselor, activităţilor din proiect. 
Deoarece alocarea resurselor este întotdeauna acompaniată de supra-alocarea resurselor, acest 
capitol explorează cauzele supra-alocării resurselor şi sugerează metode de rezolvare a 
conflictelor. 

1.Întelegerea apariţiei conflictelor 
În timpul alocarii resurselor, Microsoft Project se asigură că o resursă lucrează 

verificând calendarul resursei. Totuşi, Microsoft Project nu accesează ceea ce resursa are deja 
ca angajament atunci cand i se atribuie o nouă activitate, Project lasând acest lucru la 
îndemâna utilizatorului. Atenţie însa, pentru că alocarea de activităţi suplimentare unei resurse 
poate duce la supra-alocarea resursei. Supra-alocarea apare atunci când unei resurse i se 
atribuie mai multa muncă decat poate aceasta face în intervalul in care munca ar trebui sa fie 
indeplinită cu succes. 

De exemplu, dacă atribuiţi lui Mary două activităţi pentru un program de lucru întreg, 
care sa înceapa în acceasi zi, de fapt i-aţi atribuit un program de lucru de 16 ore într-o zi de 
lucru de 8 ore – imposibil, cu exceptia cazului în care Mary este un angajat foarte dedicat care 
nu are viaţă în afara muncii. Pe de altă parte, dacă aveţi un grup de trei mecanici şi repartizaţi 
doi mecanici sa lucreze la aceelaşi activitate în aceeaşi zi, înca mai aveţi un mecanic 
suplimentar fară supra-alocare. 

Figura 10-1 arată o serie de activităţi în “Planul de divertisment” şi “Relaţii publice” 
care încep în aceeaşi zi. Prin repartizarea aceleeaşi resurse acestora, supra-alocarea este 
inevitablila. Supra-alocarile cauzează adesea întarzieri în programul proiectului. 



Figura 10-1: Repartizarea aceleiaşi resurse către activităţi ce se desfăşoară simultan cauzează supra-
alocare. 

 

Pentru a calcula data de start a unei activităţi, Microsoft Project verifică factori ca 
dependinţele şi constrângerile. Project verifică apoi calendarul resurselor pentru a identifica 
următoarea zi normală de lucru şi alocă acea dată pentru activitate. Dacă nu aţi alocat resurse 
activităţii, Project utilizează calendarul proiectului pentru a calcula urmatoarea zi de lucru. 
Dar, atunci când Project calculează data de start a activităţii, el nu consideră si alte 
angajamente pe care resursa le are în afara proiectului curent. 

 

2.Detectarea conflictelor de resurse 
 Inainte de a rezolva conflictele resurselor, trebuie sa le identificaţi. Puteţi folosi 

vizualizari sau filtre pentru a vă uşura identificarea problemelor supra-alocarii resurselor. 

         2.1 Utilizarea estimarilor pentru a identifica conflictele 
resurselor 

Folosiţi o estimare a resursei cum ar fi „Fişa de Estimare a Resursei” sau „Estimarea 
Utilizării Resursei” pentru a găsi conflictul resurselor. În aceste estimari resursele supra-
alocate apar colorate în rosu. Mai mult, apare un icon de atentionare în coloana Indicatorului 



pentru a semnala o resursa o supra-atribuită. Daca îndreptati mouse-ul spre icon veti vedea un 
messaj referitor la supra-alocare. Pentru informatii referitoare la adresarea supra-alocărilor, 
consultati în paginile urmatoare ale acestui capitol, „Întârzierea  activitaţilor prin egalizarea 
zoneleor de deservire ale resurselor”. 

 

Pentru a vizualiza „ Utilizarea Resursei” care este prezentata in Fig. 10-2, selectati „Resource 
Usage” din bara „View”, sau alegeti „Resource Usage”. 

 

Figura 10-2; Fereastra „Resource Usage” afiseaza resursele supra-alocate, colorate in rosu si apare 
un icon in coloana Indicatorului. 

Puteţi de asemenea vedea un grafic de reperezentare a alocarii resurselor prin 
selectarea ferestrei „Resource Graph” Pentru a afisa fereastra din Fig. 10.3, selectaţi Resource 
Graph din optinea View, sau selectati „View: Resource Graph” 



Figura 10-3: Fereastra ‚”Resource Graph”, ofera o imagine a alocarii resursei. 

 

Fereastra de Alocare a resurselor este utila în cazul lucrului cu supra-alocări. O 
diagrama Gantt, prezinta în partea de jos a ferestrei, sarcinile stabilite resursei pe care aţi 
selectat-o în partea de sus (a ferestrei). Activitatile care încep în acelaşi timp, se suprapun în 
Diagrama GANTT; aceasta fereastră vă ajută să indicati cu precizie care activitati conduc la 
supra-alocarea resursei. Partea superioară a ferestrei, din Figura 10-4, arată o supra-alocare a 
activitatii dnei Ellen Peck, Luni, 2 Iunie. Dacă studiaţi mai atent diagrama acelei zile, veti 
obseva că Ellen a lucrat 12 ore, în ziua respectivă. În partea de jos a ferestrei ea este 
înregistrata cu doua activitaţi în acelaşi timp, ca fiind si la un meci de Baseball si la Opera, iar 
fereastra Gantt, facilitează, observarea suprapunerii celor doua activitati în acea zi de Luni. 

 

 

 

 



Figura 10-4: Fereastra de Alocare a resureselor foloseşte formatul Gantt Chart pentru a prezenta 
sarcinile atribuite resursei selectate în partea superioară a panelului. 

 

Pentru a trece la fereastra de Alocare a resuresei alegeti „View”: „More Views” si apoi 
selectati „Resource Allocation” 

2.2 Utitlizarea Filtrelor pentru a indica conflictele de resurse 

Filtarea, reprezinta o alta tehnică simpla pe care o puteţi utiliza pentru a rezolva 
problemele conflictului de resurse. Daca filtrati Fereastra de utilizare a resurselor, pentru a 
afişa numai resursele supra-alocate, asa cum este prezentat in Figura 10-5 probleme sunt puse 
şi mai bine în evidenta. Pemtru a filtra fereastra, alegeti „View”: „Resource Usage”. Apoi 
deschideti „Filter list box”  din „Formatting Toobar”  si alegeti „ Overllocated Resources”, 
sau selectaţi „Project”: „Filtered”: „Overllocated Resources”. 

 

 

 

 



Figura 10-5: Puteţi filtra fereastra „Resource Usage” pentru a prezenta numai resursele supra-alocate. 

 

Apoi, adăugati câmpul „Overallocation” la fereastra pentru a identifica întinderea 
supra-alocarii resursei. Alegeti „Format”: „Details”: „Overallocation”. Dupa cum este 
prezentat in Fig. 10-6, Proiectul adauga un rând în zona scalei de timp a ferestrei pentru a va 
prezenta numărul de ore necesare pentru a elimina şi corecta supra-alocarea. 



 

Figura 10-6: Adaugă câmpul Overallocation(supra alocare)  la Resource Usage view. 
 

     3.Rezolvarea Conflictelor 
 După ce găsiţi supra alocarile, trebuie să rezolvaţi conflictele. Managerii de proiecte  
utilizează mai multe metode pentru a rezolva conflictele. 

 3.1 Schimbarea alocării de resurse 

 Dacă vă jucati puţin cu alocarea de resurse, puteţi rezolva un conflict de resurse. 
Adăugarea unei resurse este un mod ciudat de rezolvare a supra alocarii. De exemplu 
presupunem că activitatea 3 este o activitate effort care are un conflict de resurse cu 
activitatea 4.  Cele două activităţi nu rulează concomitent, dar activitatea 3 continuă când 
activitatea 4 ar trebuii să înceapă. Presupunem, de asemenea că avem nevoie de aceeaşi 
resursă, Deena Tanenblatt, să lucreze la ambele activităţi. Adăugarea unei resurse (Do Lahr) 
la activitatea 3 reduce timpul necesar terminarii activităţii 3, care poate elimina conflictul 
Deena între activităţile 3 şi 4. 

 



 Se pot adăuga resurse folosind tehnici care au fost prezentate în capitolul 5, sau se pot 
adăuga resurse unei activităţi folosind vizualizarea Resource Usage (descris mai tarziu în 
acest capitol). 

 3.1.1 Schimbarea resurselor 

 Conflictele dintre resurse pot fi de asemenea rezolvate prin schimbarea resurselor. Se 
poate folosi această tehnică atunci când o resursă este supra alocată şi există o altă resursă 
disponibilă capabilă pentru activitatea respectivă. Schimbarea resurselor are loc prin 
înlocuirea resurselor din task-ul în cauză. 

 În vizualizarea Resource Usage ne putem concentra asupra conflictelor între resurse 
(cu referire la Figura 10-2; Figurile 10-5 şi 10-6 sunt de asemenea bazate pe vizualizarea 
Resource Usage). Este indicat să creaţi o vizualizare combinată, care contine în partea de sus 
Gantt Chart şi vizualizarea Resource Usage în partea de jos, înainte de schimbarea resurselor 
(vezi Figura 10-7). 

 
Figure 10-7: Folosirea vizualizării combinate a Gantt view şi Resource Usage view 

ajută la corectarea resurselor supra allocate. 
 

În panoul de sus selectaţi activitatea căreia doriţi să îi schimbaţi resursele. În partea de 
jos a ferestrei, Microsoft Project afişează toate activităţile corespunzătoare fiecărei resurse 
alocate activităţii selectate. Faceţi clic pe butonul Assign Resources pentru a deschide Assign 
Resources box. Evidenţiaţi resursele pe care doriţi să le schimbaţi, faceţi click pe butonul 
Replace şi selectaţi resursele care doriţi să le folosiţi pentru acestă activitate. Completaţi 



coloana Units, click OK apoi Close. Microsoft Project va schimba atribuirile, fară a afecta 
istoricul actual, şi fără să afecteze alte resurse decât cele implicate în schimb. 

Dacă utilizaţi Project Server puteţi beneficia de avantajele Resource Substitution 
Wizard pentru a înlocui resurse generice automat. Vezi capitolul 21 pentru mai multe detalii. 

3.1.2 Adaugarea unei activităţi la alocarea resurselor 

Adaugarea unei activităţi la alocarea resurselor folosind acelaşi process care a fost 
descries în secţiunea precedentă “Schimbarea resurselor” cu excepţia că nu mai înlocuim o 
resursă. Folosiţi vizualizarea combinată în care Gantt Chart apare în panoul de sus şi 
vizualizarea Resource Usage apare în panoul de jos. În panoul de sus cautaţi şi faceţi clic pe 
activitatea la care doriţi să adăugaţi o resursă. În partea de jos a ferestrei, Project afişează 
toate activităţile corespunzătoare fiecărei resurse alocate activităţii selectate. Faceţi clic pe 
butonul Assign Resources pentru a deschide Assign Resources box. Evidenţiaţi resursele pe 
care doriţi să le adăugaţi, completaţi coloana Units şi faceţi clic pe butonul Close. Project va 
adăuga resursele activităţii. 

3.1.3 Adăugarea sau ştergerea unei alocări de resurse 
 
Puteţi adăuga sau şterge o alocare de resurse prin utilizarea unui număr mare de 

tehnici.  De exemplu, puteti lucra în vizualizarea Gantt Chart, apoi împarţiţi vizualizarea 
(selectaţi Window->Split) pentru a afişa vizualizarea Task Entry ( o vizualizarea combinata 
cu Gantt Chart în planul de sus şi Task Form în planul de jos). Selectaţi o activitate din 
vizualizarea Gantt Chart apoi faceţi următoarele : 

 
 Pentru a adăuga o alocare de resurse, selectaţi o resursă din lista care apare 

când faceţi clic pe coloana Resource Name din vizualizarea Task Entry. 
 Pentru a sterge o alocare de resurse, selectaţi numarul ID al resurselor în 

vizualizarea Task Entry şi apăsaţi Delete. 
 Pentru a schimba resurse, folosiţi fereastra dialog Replace Resource (vezi 

Capitolul 5 pentru mai multe detalii). 
 

Lucrul în vizualizarea Gantt Chart este efectivă, dar vizualizarea Resource Usage 
ne      ajută să ne concentrăm asupra conflictelor între resurse.   
 
 

 
 
Atenţie! Nu trebuie să ştergeţi resursele alocate, care conţine munca actuală . Dacă o faceţi, 
veţi avea informaţii înşelătoare cu privire la task. Să presupunem, de exemplu că alocăm o 
resursă pentru o activitate, resursa îşi termină activitatea, apoi este ştearsă alocarea resursei. 
Project arată activităţile realizate dar nu veţi realize nimic la nivel de activitate. 
 

3.2 Programarea orelor suplimentare 
 
Un conflict de resurse poate fi rezolvat şi prin programarea orelor suplimentare pentru 

resurse. Orele suplimentare în Project, reprezintă activităţile care sunt programate peste orele 
normale de lucru ale resursei şi sunt taxate la o rată de ore suplementare ale resurselor. Orele 



suplimentare nu reprezintă muncă suplimentară la o activitate, în schimb ele reprezintă timpul 
petrecut la o activitate în afara programului de lucru normal. Prin programarea orelor 
suplimentare resursele pot termina o activitate mai repede şi elimină conflictul. După cum aţi 
citit în ultimul capitol, alocarea orelor suplimentare poate fi realizată din vizualizarea Gantt 
Chart. Folosiţi paşii următori pentru a programa orele suplimentare: 

1. Alegeţi vizualizarea Gantt Chart (View➪Gantt Chart). 
2. Alegeţi Window � Split pentru a schimba vizualizarea Task Entry şi în 

panoul de jos se va dezvălui Task Form. 
3. Faceţi clic pe Task Form pentru a face panoul activ. 
4. Alegeţi Format➪Details➪Resource Work. Project afişează coloana Ovt. 

Work în panoul Task Form, după cum apare în Figura 10-8. În această 
coloană, 0h înseamnă că nu aţi alocat încă orele suplimentare. 

5. Selectaţi activitatea din panoul de sus căreia doriţi să îi alocaţi ore 
suplimentare. 

6. Mergeţi la panoul de jos, si completaţi suma de ore suplimentare pentru 
resurse 

 
Când aţi terminat introducerea orelor suplimentare, vă puteţi ascunde Task Form 
prin alegerea Window -> Remove Split. 
 
 

F
igura 10-8: Utilizaţi Task Form, şi afişaţi coloana Overtime pentru a adăuga ore suplimentare. 

 



 3.3 Redefinirea calendarului pentru resurse 

Dacă o resursă este o resursă salariată, s-ar putea să aveţi posibilitatea să îi redefiniţi 
calendarul, astfel încât orele considerate nelucrătoare (şi, prin urmare, încărcat de la o rată de 
ore suplimentare, dacă a lucrat) devin ore lucrătoare. Dacă o resursă are un conflict, iar 
numarul de ore în conflict pentru o anumită zi este destul de scăzut, puteţi elimina conflictul 
mărind numarul de ore lucrătoare pentru resursă în acea zi. 

Puteţi aplica acest tip de schimbare la orice resursă – Project nu vă va opri. Dar 
trebuie să aveţi în vedere şi efectele privind costul proiectului. Dacă plătiţi o 
resursă la o rată de ore suplimentare pentru a lucre în afara orelor de lucru, nu 

doriţi să schimbaţi orele nelucratoare în ore lucrătoare în Project. Dacă veţi face asta, costul 
proiectului va fi minim. 

 

Pentru a schimba calendarul resurselor care lucrează mergeţi la vizualizarea Resource Usage. 
Identificaţi resursa care are un conflict şi notaţi numărul de ore care este implicat în conflict. 
Dubluc clic pe resursa care are un conflict pentru a deschide fereastra dialog Resource 
Information pentru acea resursă. Clic pe tab-ul Working Time pentru a vizualiza calendarul 
resursei respective după cum este afişat în Figura 10-9. 

 

Figura 10-9: Folosiţi tab-ul Working Time din fereastra dialog Resource Information pentru a schimba 
orele standard de lucru pentru resurse. 

 

 



 Pentru a schimba orele standard de lucru pentru o resursă urmaţi paşii următori: 

1. Faceţi clic pe prima dată la care a resursele sunt supra alocate.  

2. Selectaţi butonul opţiune Use default. 

3. Utilizaţi From şi To boxes pentru a seta ore de lucru nonstandard pentru acea zi. 

4. Repetaţi acest proces pentru fiecare zi în care doriţi să schimbaţi programul de lucru  
pentru o anumită resursă. 

5. Clic OK când terminaţi. 

 
   3.4  Alocarea muncii cu jumătate de normă 
 

Să presupunem că o resursă este atribuită la mai multe activităţi concurente şi este 
supra-alocată.Să presupunem totodată că nu mai doriţi să adăugaţi resurse, să schimbaţi 
resursa, sau să adăugaţi întârzieri.Puteţi să puneţi resursa să lucreze cu jumătate de normă la 
fiecare dintre activităţi pentru a rezolva conflictul, dar îndeplinirea lor ar dura mai mult dacă 
se foloseste această metodă.Sau puteţi  folosi această metodă în combinaţie cu resurse 
adiţionale pentru a vă asigura că terminaţi activitatea la timp. 

 

Pentru a seta o resursă să lucreze cu jumătate de normă, puteţi schimba numărul de unităţi din 
resursa respectivă alocată initial activităţii în cauză.Implicit, Project pune tipurile activităţii la 
Fixed Units.Dacă schimbaţi durata de timp în care resursa lucrează la o activitate, în 
consecinţă Project schimbă durata activităţii. 

 

Notă: 

 

Pentru a reţine durata şi a aloca o resursă să lucreze cu jumătate de normă la o activitate, 
schimbaţi tipul activităţii la Fixed Duration.Prin această schimbare, specificaţi că activitatea 
va fi încheiată de resursă în timpul alocat – efectiv , scurtaţi perioada de timp care este 
necesară pentru a termina activitatea deoarece necesită mai puţin efort în aceeaşi perioadă de 
timp. 

 

Pentru a schimba tipul activităţii la Fixed Duration, urmaţi aceşti paşi: 

 

1. Views -> More Views -> Resource Allocation. 

 

2. Daţi click pe activitatea pe care doriti să o schimbaţi în panoul de sus.Project arată 
acea activitate în formatul Gantt în panoul de jos.  

 



3. Dublu-click pe activitatea pe care doriţi să o modificaţi în panoul de jos.Va apărea o 
casetă de dialog Task Information.Click pe fila Advanced ca în Figura 10-10.  

 

4. Deschideţi caseta lista Task type şi selectaţi Fixed Duration. 

 

5. Click OK.  

 

           Figura 10-10: Folosiţi fila Advanced a casetei de dialog Task Information pentru a 
schimba tipul activităţii.  

Acum puteţi aloca resurse pentru a lucra cu jumătate de normă la această activitate fără a 
schimba durata ei.Urmaţi aceşti paşi pentru a aloca resurse: 

 

1. În vizualizarea Resource Allocation, daţi click pe o activitate în panoul de sus la care 
resursa supra-alocată este atribuită.  

 

2. Click pe butonul Assignment Information în bara de instrumente Standard, sau dublu-
click pe activitate pentru a deschide caseta de dialog cu Assignment Information.Puteţi 
vedea fila General în Figura 10-11.  



 Figura 10-11: Folosiţi caseta de dialog Assignment Information pentru a schimba 
cantitatea de muncă prestată de o resursă într-un interval de timp 

 

3. Schimbaţi valoarea implicită în caseta Units (100%) pentru a reflecta procentul de 
timp pe care doriţi să îl alocati resursei pentru lucrul la o activitate – în acest caz, 
valoarea ar trebui să fie mai mică decât 100%.  

 

4. Click OK.  

 

 3.5 Controlul asupra resurselor în privinţa începerii lucrului la 
o anumită activitate 

 

Pentru cazuri în care atribuiţi mai mult de o resursă pentru o activitate, luaţi în considerare 
decalarea timpilor de începere a lucrului la activitate pentru a rezolva conflictele legate de 
resurse.Când întârziaţi începerea lucrului la o activitate a unei resurse, Project recalculează 
data de start şi timpul de lucru la acea activitate.Pentru a decala timpii de start al resurselor, 
mergeţi în vizualizarea Task Usage şi urmaţi următorii paşi : 

 

Notă: 

 

Această tehnică poate extinde durata activităţii, ceea ce nu constituie o opţiune viabilă. 

 

1. View - > Task Usage.  

 

2. Selectaţi resursa al cărei lucru doriţi să îl întârziaţi în coloana Task Name.  

 



3. Click pe butonul Assignment Information sau dublu-click pe resursă.Va apărea fila 
General a casetei de dialog Assignment Information (aşa cum s-a arătat precedent în 
Figura 10-11).  

 

4. Schimbaţi datele în casetele Start şi Finish.  

 

5. Click OK.  

 

Sfat: Puteţi modifica datele de start şi final direct din tabelul Task Usage. 

 

3.6 Întârzierea activităţilor prin nivelarea cantităţii de muncă 
prestată de o resursă într-un interval de timp 
 

Daca aţi programat mai multe activităţi să se desfăşoare concurent şi acum găsiţi conflicte de 
resurse în proiect, puteţi întârzia câteva dintre acele activităţi pentru a echilibra cererile 
asupra resurselor.Nivelarea este procesul prin care se rezolvă conflictele legate de resurse prin 
întârzierea sau divizarea activităţilor având la bază orarele resurselor alocate.Project poate să 
selecteze activităţile pe care să le întârzie sau să le împartă prin folosirea proprietăţii sale de 
nivelare, sau puteţi controla procesul manual prin examinarea proiectului pentru a identifica 
activităţile pe care sunteţi dispus să le întârziaţi sau divizaţi. 

 

3.6.1 Nivelarea automată 
 

Când Project face nivelarea, redistruie resursele şi le reprogramează în concordanţă cu 
capacitatea de lucru, unităţile alocate şi calendarul.Project ia în considerare şi durata 
activităţii, constrângerile şi prioritatea. 

 

Ce este prioritatea unei activităţi?În unele circumstanţe, Project echilibrează anumite 
activităţi înainte de a le echilibra pe altele.Puteţi face asta prin atribuirea unui nivel diferit de 
prioritate activităţilor.Implicit, Project atribuie tuturor activităţilor prioritate 500.Dacă atribuiţi 
priorităţi diferite la activităţi, Project le ia în considerare atunci când echilibrează şi încearcă 
să evite întârzierea lor în funcţie de nivelul lor, de la cea mai importantă până la cea mai puţin 
importantă prioritate.Efectiv, Project întârzie activităţile cu prioritate mai mică înainte de a le 
întârzia pe cele cu prioritate mai mare; dacă totul este la fel, Project va întârzia activitatea cu 
prioritatea 5, înaintea uneia cu prioritate 15.Deci, înainte de a începe să folosiţi proprietatea de 
nivelare automată, luaţi în considerare prioritatea activităţilor. 

 

Sfat: Prioritatea 1000 este tratată într-un mod special ; Project nu va întârzia nicio activitate 
căreia îi veţi atribui prioritate 1000. 

Pentru a seta o prioritate, urmaţi aceşti paşi: 

 



1. View -> Gantt Chart. 

 

2. Dublu-click pe activitatea căreia doriţi să îi setaţi prioritatea, sau selectaţi activitatea şi 
daţi click pe butonul Task Information în bara de instrumente Standard.Project 
afişează caseta de dialog Task Information. 

 

3. Folosiţi fila General pentru a seta o prioritate, aşa cum este indicat în Figura 10-12. 

 

Sfat: E posibil să setaţi priorităţi din elementele vizualizării Gantt Chart sau Task Usage, unde 
cu uşurinţă puteţi vedea priorităţile activităţilor vecine. 

 

Figura 10-12: Setează prioritatea unei activităţi. 

 

Sfat: După ce prioritizaţi activităţile – dar înainte de a echilibra – le puteţi sorta după 
prioritate pentru a vedea care sunt cele mai probabile, pe care le va folosi Project, pentru 
nivelare. 

 

Pentru a echilibra activităţi în mod automat, urmaţi aceşti paşi : 

 

1. Tools -> Level Resources pentru a deschide caseta de dialog Resource Leveling aşa 
cum este indicat în Figura 10-13. 

 

2. Selectaţi butonul cu opţiunea Automatic pentru ca Project să echilibreze automat 
resurse, în caz că faceţi o schimbare în orar.Selectaţi Manual pentru a echilibra doar 



când daţi click pe butonul Level Now în această casetă de dialog. 

 

3. Folosiţi caseta Look for overallocations on a ... basis pentru a selecta un punct de 
start.Punctul de start este un cadru de timp, cum ar fi zi de zi, săptămână de 
săptămână.(caseta Indicator în perspectiva Resourse Usage poate conţine note care 
sugerează punctul de start adecvat.) 

 

 
 Figura 10-13: La caseta de dialog Resource Leveling puteţi seta optiunile de nivelare a 

resurselor. 

4. Selectaţi caseta Clear leveling values before leveling pentru a face comportamentul 
Project 2003 ca Project 98 în cazul echilibrării – şi anume, Project resetează toate 
valorile întârziate (din cauza echilibrării) la 0 înainte de nivelare.Dacă nu selectaţi 
această casetă, Project 2003 nu resetează valorile de nivelare, ci construieste pornind 
de la acele valori.În timpul echilibrării, programarea activităţilor echilibrate ulterior , 
probabil, nu se va schimba. 

 

5. În panoul Leveling range for, selectaţi nivelarea întregului proiect sau nivelarea doar 
pentru date specifice. 

 

6. În caseta Leveling order list, selectaţi ordinea în care Project să facă nivelarea 
proiectului.Dacă selectaţi ID Only, Project întârzie sau divizează activitatea cu cel mai 
mare ID.Dacă selectaţi Standard, Project se uită la dependenţele predecesorului, 
limitare, date şi priorităţi atunci când selectează activitatea de fragmentat sau 



întârziat.Dacă selectaţi Priority, Standard, Project se uită mai întâi la prioritatea 
activităţii şi apoi la toate elementele care sunt listate la ordonarea pentru nivelarea 
Standard. 

 

7. Selectaţi oricare dintre următoarele opţiuni: 

 

• Level only within available slack: aceasta evită  schimbarea datei de terminare a 
proiectului. 

 

• Leveling can adjust individual assignments on a task: În acest caz, nivelarea ajusteaza 
orarul de lucru al unei resurse independent de alte resurse care lucrează la aceeaşi 
activitate. 

 

• Leveling can create splits in remaining work: Permite nivelarea prin fragmentarea 
activităţilor pentru a rezolva conflictele legate de resurse. 

 

• Level resources with the proposed booking type: Selectaţi această căsuţă pentru ca 
Project să includă activităţi care conţin resurse propuse în timpul procesului de 
nivelare. 

 

8. Click pe Level Now pentru a realiza nivelarea. 

 

Puteţi să vedeţi efectele echilibrării în vizualizarea Leveling Gantt Chart, aşa cum este indicat 
în Figura 10-14.Alegeti Views -> More Views -> Leveling Gantt şi apoi daţi click pe butonul 
Apply.Project adaugă bare verzi la diagrama Gantt, reprezentând durata fiecărei activităţi 
înainte de nivelare.În functie de natura proiectului, Project poate adăuga limitări în activităţi. 

 



Figura 10-14: Vizualizarea Leveling Gantt Chart arată cum nivelarea afectează proiectul. 

 

Pentru a scoate efectele echilibrării, redeschideţi caseta de dialog Resource Leveling (Tools -> 
Level Resources) şi daţi click pe butonul Clear Leveling.O casetă de dialog ulterioară vă 
permite să curăţaţi nivelarea pentru întregul proiect sau doar pentru anumite activităţi. 

 

 

 

 

 

 

 

 

 



   

  Notă : Dacă  se încearcă planificarea  de la o dată terminată , încă  se mai poate 
organiza pentru a rezolva conflictele de resurse .  Proiectul calculează întarzierea ,extrăgând-o 
din data de terminare a unui task sau a unei sarcini .Aceasta va cauza  ca data de terminare sa 
apară  mai devreme.  

 

 

   3.6.2 Nivelarea manuală 

 

 Nivelarea Manuala este eficientă mai ales când nivelarea automată nu întoarce rezultate 
acceptabile . Nivelarea Manuală este deasemenea eficientă când  se are spre  rezolvare  puţine 
conflicte între resurse .  Pentru a organiza manual resursele într-un Proiect  foloseşte   
Resource Allocation View si urmează  paşii : 

 

      1     Alege View -> More Views .  Din dialog-ul  More Views  , selectează Resource 
Allocation  şi apasă Apply. 

   

2     Selectează task-ul pe care doreşti  să îl întârzii  din partea de sus a panoului . 
 

     3    În partea de jos a panoului, întroduceţi o valoare în câmpul   Leveling Delay. Proiectul    
întârzie taskul  în mod corespunzător şi reduce conflictul de resursă.  

 

 Pozele din figurile 10-15 si 10-16 arată nivelarea resurselor înainte şi după nivelarea 
manuală.  S-a  folosit o simplă situaţie  pentru a demonstra efectele  organizării manuale : Am 
creat un proiect cu doar două  task-uri  şi o resursă, alocând integral aceleaşi resurse ambelor 
taskuri. De observat că nivelarea manuală pentru al doilea task îl întârzie pe acesta astfel încât 
va incepe după terminarea primului task. 



 

Figura 10-15:  Resource Allocation View înainte de nivelarea manuală 



Figura 10-16:  Resource Allocation view după  nivelarea manuală 

 

       3.7 Conturarea resurselor 

Conturarea este un termen pe care Proiectul îl foloseşte pentru a se referi la forma asignării 
muncii unei resurse de-a lungul timpului.Conturarea îmbracă mai multe forme ,cele mai 
cunoscute sunt Flat, Back Loaded, Front Loaded şi Bell. Conturarea implicită este Flat, ceea 
ce înseamnă că o resursă lucrează pe un task numărul maxim de ore pentru care i-a fost 
asignat pentru durata sarcinii. Pot fi folosite diferite tipuri de contururi pentru a controla cât e 
planificată o resursă să lucreze pe un anumit task la un moment dat – putând fi rezolvat astfel 
şi un potenţial conflict. 

 

Indiciu : 

Adăugaţi câmpul Pick Units la Resource Usage view pentru a afişa efortul maxim.- distribuit în timp- 
pentru care o resursă trebuie să lucreze. Acest câmp este în special util atunci când selectezi o altă 
conturare decât cea implicită. 

  Conturarea Flat atribuie o resursă să lucreze numărul maxim de ore în intervalul de timp pe 
toată durata sarcinii. Schimbând conturarea, modelul de lucru al unei resurse poate fi reflectat 
cu mai multă acurateţe  cât timp resursa lucrează la un task.  

 



Pentru a înţelege mai bine conturarile, se împarte sarcina în 10 timesloturi egale . Folosind 
diferitele contururi , Proiectul atribuie diferite procente de muncă ce urmează a fi efectuate  în 
fiecare timeslot  .Contururile  ajută la atribuirea de lucru unei sarcini , atunci când sarcina 
necesită efort. De exemplu dacă sarcina necesită mai puţin efort inţial ,atunci trebuie luat în  
considerare folosirea unui contur Back Loaded .  Dacă sarcina necesită cel mai mult efort   la 
mijloc ,atunci trebuie luat în considerare folosirea unui contur Bell ,Turtle sau chiar Early 
Peak. 

 
 
Atenţie !!! Dacă se incepe schimbarea contururile de la cel implicit Flat poate fi  creat 
inevitabil un conflict de resurse  .Prin urmare vizionarea  conturului ales poate ajuta la 
rezolvarea conflictelor de resurse .  

 
 
      3.7.1 Stabilirea unui model de contur  
 
   Pentru a seta un model de contur trebuie urmaţi aceşti paşi : 

 
  1 ) Se alege View-> Task Usage.  În porţiunea de foaie a view-ului Proiectul afişează 
taskurile din proiect cu resursele asignate şi afişate mai jos de sarcină, afişând numărul de ore 
pe zi ale unei resurse asignate unei sarcini .  

 
     2) În coloana Task Name ,  se dă double-click pe   resursa pentru care doreşte 
aplicarea unui contur sau se selectează resursa şi se dă click pe butonul Assignment 
Information din toolbar-ul Standard. Apoi se dă click pe tabul General din dialogul  
Assignment Information , ca în figura 10-17. 

 

 



  
Figura 10-17: Folosirea tab-ului General al ferestrei Assignment Information pentru a selecta un 

contur 

     

 3) Se deschide apoi list-box-ul pentru Work Contour  şi  se selectează un contur .   

  4) Apoi OK .    

 
  Indiciu : Pentru a schimba datele de început şi sfârşit a lucrului unei resurse pe un task se 
folosesc list-boxurile Start şi Finish .  

    

 Când este selectat un contur diferit de Flat , un indicator apare lângă resursă în coloana 
Indicator . La trecerea mouse-ului peste indicator, Proiectul identifică  conturul care a fost 
aplicat resursei , ca în figura 10-18. 

 
 
 
     
  



          
 Figura 10-18: Proiectul afişează o iconiţă în coloana Indicator , în dreptul resursei pentru care 

s-a ales un contur, altul decât cel Flat  
 
   

 Indiciu : Aceeaşi iconiţă apare în coloana indicator din view-ul Resource Usage. 

 

Următoarele observaţii trebuie avute în vedere când se folosesc contururi :  

     - Presupunând că se aplică alt contur decât cel default sau implicit (Flat) unei sarcini, şi 
mai tarziu se aplică sau se adaugă un nou total al valorilor de muncă al unei sarcini. Proiectul 
aplică automat modelul de contur sarcinii şi resurselor distribuind pentru început noile valori 
de muncă ale sarcinii peste perioada de timp atribuită şi apoi atribuind noi valori de muncă 
resurselor care lucrează pe sarcină. 

    - Daca este setat un contur şi apoi se schimbă data de început a unei sarcini sau data de 
început pentru munca unei resurse atribuite unei sarcini, Proiectul şiftează automat conturul şi 
îl reaplică pentru a include noua data, astfel încât păstrează modelul conturului original. 

 - Dacă creşteţi durata unei sarcini, Proiectul întinde conturul pentru a include noua durată. 
Presupunând că aplicaţi un contur altul decât cel default. Dacă editaţi manual o valoare 
pentru lucru pe porţiunea view-ului ce afişează conturul, Proiectul nu va mai aplica 
automat modelul de contur. Totuşi, puteţi reaplica conturul pentru a redistribui noile valori. 
 
 - Dacă introduceţi valoarea de munca actuală şi apoi schimbaţi totalul sarcinii de muncă 
sau totalul de muncă ramas, Proiectul automat va redistribui schimbările valorilor de 
muncă rămase şi nu valorii actuale de muncă. 



 

      3.7.2 Conturarea disponiblităţii resursei 

 

Incepand cu Project 2000, puteti contura disponibilitatea unei resurse. Pentru a face asta, 
folositi tabul General al dialogului Resource Information, ca in figura 10-19. In list-box-ul 
Resource Availability, setati datele Available From si Available To ale resursei selectate. O 
anume resursa poate fi disponibila sa lucreze pe proiectul tau numai jumatate de norma pentru 
un cadru de timp specificat. Sau, presupunand ca ai deja cinci programatori, dar numai trei 
sunt disponibili in august si unul se retrage in septembrie. Folositi sectiunea Resource 
Availability pentru a specifica disponibilitatea resurselor ce va influenta nivelarea proiectului. 

                   

       Figure 10-19: Setează date care reprezintă disponibilitatea resursei astfel încat se poate    
asigna o resursă unei sarcini folosind numai datele pentru care resursa este disponibilă  

 

            3.8  Punerea în comun a resurselor 

În final, se poate încerca rezolvarea conflictelor de resurse punându-le în comun. Un resourse 
pool este un set de resurse ce sunt disponibile pentru orice proiect. Se poate folosi resursele 
exclusiv pe un proiect sau se pot împărţi resursele mai multor proiecte. În  mod normal, 
resource pooling este util numai atunci dacă se lucreayă cu aceleaşi resurse pe mai multe 
proiecte şi nu se foloseşte Project Server. Project managerii pot împărţi aceleaşi resurse. 
Pentru ca resource pooling este atât de legat de administrarea mai multor proiecte, se va 



reveni cu detalii în capitolul 15; în acel context, se va putea întelege mai bine punerea în 
comun a resurselor unei aplicaţii în rezolvarea de conflicte (de resurse). 

Dacă se foloseşte Project Server, nu mai e nevoie să fie folosit resource pooling. În schimb, se 
va dori folosirea Enterprise resources şi a Resource Substitution Wizard pentru a rezolva 
conflictele de resurse. A se vedea capitolele 19 si 21 pentru mai multe informaţii. 

 

 4. Sumar 
 În acest capitol a fost explicat cum să se identifice şi să se rezolve conflictele de 
resurse ce pot întârzia un proiect. Tehnicile implicate includ următoarele : 

- schimbarea alocărilor de resurse; 
- programarea orelor suplimentare; 
- redefinirea unui calendar al resursei; 
- asignarea de lucru cu jumătate de normă; 
- controlarea timpilor de start al unei resurse; 
- nivelarea încărcării de muncă a unei resurse; 
- conturarea resurselor. 

 

În următorul capitol, se va prezenta arta urmăririi progresului prin compararea lui cu faza 
iniţială. 

 

 



 5. Aplicaţii 
   

 1. Imaginaţi o situaţie concretă din timpul dezvoltării unui proiect software de tipul 
celei din figura de mai jos. Cum se poate evita supra-alocarea primei resurse? Ambele resurse 
lucrează cu normă întreagă. 
 

 
 
 
 2. Pentru proiectul de la punctul 1, imaginaţi o situaţie în care pentru alte două sau mai 
multe activităţi o resursă este supra-alocată şi una liberă. Echilibraţi situaţia. 
 
 
 3. În continuare, pentru proiectul de la punctele 1 şi 2, imaginaţi o situaţie de tipul 
celei din figura de mai jos, în care două activităţi se desfăşoară în paralel. Ambele resurse 
trebuie să lucreze la ambele activităţi. Dacă durata activităţilor nu este foarte importantă, cum 
se poate evita supra-alocarea resurselor? 
 

 
 
 

4. Pentru acelaşi proiect, adăugaţi o activitate pentru care este necesară înlocuirea unei 
resurse pentru a evita supra-alocarea. Înlocuiţi resursa cu ajutorul funcţiei de înlocuire 
(„Replace”) din fereastra de atribuire a resurselor. 
 
 

5. Pentru proiectul CMSProjectPlan.mpp, adăugaţi resurse la toate activităţile. Studiaţi 
gradul de încărcare al acestora şi apoi nivelaţi automat resursele cu ajutorul MS Project. 
 


